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ВВЕДЕНИЕ
В современном быстро меняющемся мире компьютерных технологий 
очень востребованы люди, владеющие компьютером и имеющие ху-
дожественный вкус. К числу этих людей в первую очередь относят-
ся дизайнеры, которые должны облагораживать человеческий быт. 
Данная книга посвящена освоению компьютерной графики, которая 
стала гибким и незаменимым инструментом дизайнера (наряду с тра-
диционными инструментами). 

В соответствии с учебным планом студенты специальности 070601 
(и бакалавры направления 072500) «Дизайн» изучают курс «Компью-
терной графики». При изучении этого курса студенты одновременно 
с освоением лекционного теоретического материала должны полу-
чать навыки по обработке изображений с применением современных 
редакторов растровой графики. В качестве такой программы в данной 
работе используется графический редактор Adobe Photoshop. 

Графический редактор Adobe Photoshop разработан одной из ве-
дущих компаний в области компьютерной графики – Adobe (США). 
Первая версия программы появилась в 1990 году, в дальнейшем она 
превратилась в промышленный стандарт в области создания, обра-
ботки и редактирования растровых изображений. 

Новейшая версия, описанная в пособии, – Adobe Photoshop CS6 – 
является результатом его эволюционного развития. Графический ре-
дактор Adobe Photoshop CS6 устанавливается в операционной систе-
ме Windows Vista или Windows 7 с процессором Intel Pentium IV (или 
AMD Athlon 64), оперативной памятью 2 Гб, видеокартой с памятью 
512 Мб и занимает дисковое пространство порядка 1,5 Гб. 

Данное пособие является переработанным изданием работы: Абба-
сов И. Б. Основы графического дизайна на компьютере в Photoshop 
CS3: учеб. пособие. – М.: ДМК Пресс, 2008. – 224 с. [1, 2]. В учебном 
пособии использован многолетний опыт работы автора в качестве 
преподавателя компьютерно-графических дисциплин. Учебно-мето-
дический материал, представленный в пособии, прошел успешную 
апробацию в течение 10 лет в Таганрогском технологическом инсти-
туте Южного федерального университета. Учебное пособие было ла-
уреатом конкурса на лучшую научную книгу 2008 года Фонда разви-
тия отечественного образования (г. Сочи), всероссийской выставки 
учебно-методических изданий Российской Академии естествознания 
«Золотой фонд отечественной науки 2009» (г. Москва).
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Упражнения выполняются на примере авторских рисунков, пред-
ставленных на сайте издательства (http://www.dmk-press.ru/files/
download/978-5-94074-916-5.rar) . Изображения разделены по темати-
ке упражнений в виде уроков. Все рисунки, представленные на данном 
сайте, являются авторскими, фотографии (кроме студийных фотогра-
фий моделей) сделаны также автором. 

Данное пособие выполнено по технологии пошагового освоения: 
от создания чистого документа до применения сложных настроек 
команд и инструментов. Их освоение осуществляется конкретными 
упражнениями. Необходимо отметить, что в упражнениях каждый 
шаг описан достаточно подробно. Однако чтобы не ограничивать 
свободу творчества, после описания возможностей команд и инстру-
ментов представлены работы для самостоятельного выполнения. 
Освоение курса заканчивается выполнением экзаменационной гра-
фической работы творческого характера. Для проверки освоенного 
материала также приведены контрольные вопросы.

В работе рассматриваются следующие вопросы:
 окно редактора Photoshop, панели и палитры;
 основные понятия растровой графики; 
 создание нового изображения, установка единиц измерения;
 форматы файлов для хранения изображений; 
 холст и редактирование параметров холста;
 изменение размеров и разрешения изображения;
 создание и редактирование слоев;
 цветовые модели, каналы;
 выделение областей правильной и произвольной формы;
 трансформация выделенных областей;
 выбор и создание цвета;
 заливка и обводка областей;
 инструменты для рисования и их настройка;
 удаление фрагментов изображения;
 тоновая коррекция изображений; 
 цветовая коррекция изображений; 
 создание маски, альфа-каналы, маска слоя;
 векторные контуры и фигуры;
 создание и редактирование текста; 
 корректирующие инструменты;
 фильтры эффектов и деформаций;
 вывод изображений на печать; 
 контрольные вопросы.



Глава 1
Окно графического 

редактора Adobe 
Photoshop CS6

После запуска графического редактора Adobe Photoshop CS6 и от-
крывания документа на экране появляется окно, которое изображено 
на рис. 1.1.

Рис. 1.1  Окно редактора

На данном рисунке представлена расширенная версия графическо-
го редактора Adobe Photoshop CS6 Extended, которая предназначена 
для более профессионального использования. Окно (интерфейс) гра-
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фического редактора является аналогичным приложениям, работаю-
щим в операционной системе Windows, и включает в себя окна, меню, 
иконки, пиктограммы, всплывающие подсказки. 

В верхней части окно редактора начинается со строки меню. Для вы-
бора соответствующего меню необходимо щелкнуть на его названии ле-
вой кнопкой мыши. Из этих названий выпадут вниз соответствую щие 
меню. Команды с треугольником на конце имеют подменю, которое мо-
жет появляться, если подержать на ней указатель мыши. Для выполне-
ния команды необходимо подвести к ней указатель мыши и щелкнуть. 

Ниже строки меню находится панель управления текущим инстру-
ментом. В левой части рабочей области располагается панель инстру-
ментов. В центре экрана находится окно документа, в правой части 
окна расположены наборы палитр. В нижней части окна документа 
расположена строка состояния. По умолчанию интерфейс версии 
редактора Adobe Photoshop CS6 имеет затемненный вид [3]. По мне-
нию разработчиков, темный фон помогает пользователям сосредото-
чиваться на более контрастном изображении документа. 

Цвет внешнего вида окна редактора можно изменить с помощью 
команды Edit ⇒ Preference ⇒ Interface (Правка ⇒ Настройки ⇒ Ин-
терфейс). В разделе Appearance (Внешний вид) предлагаются четы-
ре варианта цвета в поле Color Theme (Цветовая тема). 

Панель инструментов Tools (Инструменты) отображается в один 
или два столбца с помощью стрелок в заголовке панели. Аналогично 
можно свернуть или развернуть палитры с помощью кнопки Collapse 
to Icons (Свернуть в пиктограмму) в верхнем правом углу. Располо-
жение и набор палитр в окне редактора зависят от выполняемой зада-
чи: цветовая коррекция, рисование, ретушь, текстовый набор, анима-
ция. Все настройки рабочего пространства окна редактора находятся 
в меню Window ⇒ Workspace (Окно ⇒ Рабочая область). 

По умолчанию задано рабочее пространство Essential (Default) 
(Основная рабочая среда (По умолчанию)). Здесь же можно вернуть 
рабочую область к исходному виду по умолчанию командой Window 
⇒ Workspace ⇒ Reset Essential (Окно ⇒ Рабочая область ⇒ Сбро-
сить Основная рабочая среда). 

1.1. Содержание строки меню
Строка меню имеет следующее содержание: 

 File (Файл) – работа с файлами, создание, открытие, просмотр 
и сохранение докумен тов, настройка и запуск печати, импорт 

Содержание строки меню
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и экспорт документов, автоматическая обработка, выход из ре-
дактора;

 Edit (Правка) – отмена и возврат действий, редактирование, ко-
пирование, удаление и вставка выделен ных областей, проверка 
орфографии, обводка и заливка, деформация и трансформация 
выделенных об ластей, задание новых узоров и кистей, очистка 
буфера, система управления цветом, настройка меню и клавиа-
турных сокращений, основные настройки редактора;

 Image (Изображение) – работа с изображением в целом, цве-
товые режимы, тоновая и цветовая кор рекция, автоматические 
настройки цвета, изме нение размеров, положения холста и 
изображения, обрезка, кадрирование и дублирование изобра-
жения, обработка каналов, анализ изображения; 

 Layer (Слой) – работа со слоями, создание, дублирование, уда-
ление и сведе ние слоев, эффекты слоя, группировка слоев, рас-
пределение объектов на связанных слоях, маска слоя и т. д.;

 Type (Текст) – работа с набором текста, панели для работы 
со шрифтами, создание контура для текста, преобразование 
в трехмерный штамп, растеризация, деформация текста, уста-
новка параметров языка, замена и обновление шрифтов; 

 Select (Выделить) – работа с выделениями, инвертирование и 
трансформация выделе ния, поиск и выделение слоев, сжатие, 
расширение, растушевка и сглаживание выделения, выделение 
областей заданного цвета, альфа-каналы, загрузка и сохране-
ние выделения;

 Filter (Фильтр) – команды для работы с фильтрами, обработка 
изображений, фильтры Photoshop, ввод цифрового кода в изоб-
ражение для защиты авторских прав, загрузка новых фильтров; 

 3D (3D) – команды для работы с объемными изображениями, 
открытие, создание и редактирование слоев с трехмерными 
изображениями, рисование и визуализация текстур; 

 View (Вид) – цветовой охват, установки для цветопробы при 
печати, изменение пропорции пикселей, масштаб и режимы 
просмотра документа, показ направляющих, сеток, координат-
ных линеек, режимы привязки, создание и перемещение на-
правляющих;

 Window (Окно) – управление внешним видом редактора, вы-
бор и редактирование рабочего пространства, работа с разными 
документами, вызов панелей инструментов и плавающих па-
литр, список открытых документов;

 Help (Помощь) – справочная система. 
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Упражнение 1.1. Открытие документа
1. Скопируйте файл с библиотекой изображений с сайта изда-

тельства «ДМК Пресс» на свой компьютер, ссылка на адрес: 
http://www.dmk-press.ru/files/download/978-5-94074-916-5.rar  
и выполните команду меню File ⇒ Open (Файл ⇒ Открыть).

2. Откройте папку Уроки Photoshop. Все необходимые изображе-
ния находятся в данной папке, и они распределены по тематике 
уроков. Откройте папку Урок 1 и выберите файл Дизайн. jpg. На 
рис. 1.1 показано изображение из этого файла.

1.2. Панель инструментов
Редактор Adobe Photoshop предназначен для профессиональной ра-
боты дизайнера, художника. Поэтому панель инструментов содержит 
набор, с помощью которого можно рисовать, окрашивать, выделять 
отдельные области изображения, перемещать их и редактировать, 
вводить текст и т. д. Чтобы выбрать инструмент, необходимо щелк-
нуть на его кнопке, и инструмент после этого станет активным. Па-
нель инструментов приведена на рис. 1.2 слева.

Инструменты разделены на следующие четыре группы:
 инструменты для выделения, кадрирования изображения и 

разделения на фрагменты, для создания комментариев и вы-
полнения измерений;

 инструменты для рисования, редактирования и ретуширования;

Рис. 1.2  Панель инструментов и инструменты 
для выделения областей правильной формы 

Панель инструментов
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 инструменты для создания векторных контуров и ввода текста;
 инструменты для навигации.

На панели инструментов помещаются не все кнопки, поэтому не-
которые группы инструментов пред ставлены только одной кнопкой. 
Если кнопка содержит черный треугольник в нижнем правом углу, 
зна чит, за ней запрятаны другие инструменты. Чтобы вывести такие 
кнопки и выбрать необходимый инструмент, щелкните на передней 
кнопке и передвиньте указатель слегка вправо. Из кнопки выпадет 
список всех инструментов данной группы. 

Например, из кнопки Rectangular Marquee (Прямоугольная об-
ласть) можно вывести инструменты для эллиптического и пиксель-
ного выделения (рис. 1.2 справа). При этом выбранный инструмент 
останется видимым, а тот, что был раньше видимым, спрячется. 

Убрать или вывести панель инструментов на экран можно с по-
мощью команды Win dow ⇒ Tools (Окно ⇒ Инструменты). Рассмот-
рим содержимое данной панели.

Инструмент для перемещения Move (Перемещение)

Инструменты для выделения областей правильной фор мы: 
• Rectangular Marquee (Прямоугольная область); 
• Elliptical Marquee (Эллиптическая область);
• Single Row Marquee (Одна строка); 
• Single Column Marquee (Один столбец)

Инструменты для выделения области произвольной фор мы:
• Lasso (Лассо);
• Polygonal Lasso (Многоугольное лассо);
• Magnetic Lasso (Магнитное лассо)

Инструменты для цветового выделения:
• Magic Wand (Волшебная палочка);
• Quick Selection (Быстрое выделение)

Инструмент для кадрирования и разрезания изображения на фраг-
менты:
• Crop (Кадрирование); 
• Perspective Crop (Перспективное кадрирование);
• Slice (Фрагмент); 
• Slice Select (Выделение фрагмента)

Инструменты для выбора, измерения цвета, измерения расстояний и 
углов, создания комментариев:
• Eyedropper (Пипетка); 
• 3D Material Eyedropper (Пипетка 3D-материала);
• Color Sampler (Цветовые пробы); 
• Ruler (Измерительная линейка);
• Note (Комментарий); 
• Count (Счетчик)
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Инструменты для ретуширования:
• Spot Healing Brush (Кисть местной ретуши);
• Healing Brush (Заживляющая кисть);
• Patch (Заплатка);
• Content-Aware Move (Перемещение с учетом содержимого);
• Red Eye (Красные глаза)

Инструменты для рисования: 
• Paintbrush (Кисть); 
• Pencil (Карандаш);
• Color Replacement (Замена цвета);
• Mixer Brush (Кисть-смеситель)

Инструменты для копирования частей изображения: 
• Clone Stamp (Клонирующий штамп); 
• Pattern Stamp (Штамп узора)

Инструменты для восстановления предыдущих состояний изобра-
жения: 
• History Brush (Восстанавливающая кисть);
• Art History Brush (Художественная 
 восстанавливающая кисть)

Инструменты для удаления: 
• Eraser (Ластик); 
• Background Eraser (Фоновый ластик); 
• Magic Eraser (Волшебный ластик)

Инструменты для окраски выделенных областей: 
• Gradient (Градиент);
• Paint Bucket (Ведро с краской);
• 3D Material Drop (Выбор 3D-материала)

Инструменты для управления резкостью:
• Blur (Размытие);
• Sharpen (Резкость);
• Smudge (Палец)

Инструменты для управления яркостью:
• Dodge (Осветлитель); 
• Burn (Затемнитель); 
• Sponge (Губка)

Инструменты для рисования и редактирования векторных контуров:
• Реn (Перо); 
• Freeform Реn (Свободная форма);
• Add Anchor Point (Добавить опорную точку); 
• Delete Anchor Point (Удалить опорную точку);
• Convert Point (Преобразовать точку)

Инструменты для создания текста:
• Horizontal Туре (Текст горизонтальный); 
• Vertical Туре (Текст вертикальный);
• Horizontal Туре Mask (Текстовая маска горизонтальная);
• Vertical Туре Mask (Текстовая маска вертикальная)

Инструменты для выделения векторных контуров:
• Path Component Selection (Выделение части контура);
• Direct Selection (Прямое выделение)

Панель инструментов
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Инструменты для создания векторных фигур: 
• Rectangle (Прямоугольник); 
• Rounded Rectangle (Закругленный прямоугольник);
• Ellipse (Эллипс);
• Polygon (Многоугольник); 
• Line (Прямая); 
• Custom Shape (Пользовательская форма) 

Инструмент для панорамирования:
• Hand (Рука);
• Rotate View (Поворот вида)

Инструмент для масштабирования: 
• Zoom (Лупа)

Инструменты для индикации выбранного цвета:
• Set Foreground Color (Основной цвет);
• Set Background Color (Фоновый цвет) 

Редактирование в режиме: 
• Edit in Quick Mask Mode (Редактирование в режиме быстрого 

маскирования)

Инструменты для управления внешним видом окна редактора:
• Standard Screen Mode (Стандартное окно);
• Full Screen Mode With Menu Bar (Во весь экран с главным меню);
• Full Screen Mode (Во весь экран)

1.3. Палитры
Во время работы с изображениями обычно используются палитры, 
названные по аналогии с инструментами художника. Палитры, кото-
рые часто используются вместе, объединены в один набор. Для при-
соединения любой палитры к какой-либо группе палитр необходимо 
щелкнуть на ее яр лыке, перетащить на ярлык палитры и опустить в 
новый набор.

Каждую палитру можно свернуть до мини мальных размеров, щел-
кнув на кнопке Collapse to Icons (Свернуть в пиктограмму) в верхнем 
правом углу титульной строки, для возврата необходимо щелкнуть 
повторно. Можно плавно менять размеры палитр, перетаскивая лю-
бую ее сторону. 

В каждой палитре имеется меню, управляющее режимом ее рабо-
ты. Для вызова этого меню щелкните на треугольнике в верхнем пра-
вом углу палитры. Каждая отдельная палитра закрывается нажатием 
на крестик в конце титульной строки. Например, если палитры Color 
(Цвет) нет на экране, то ее можно вызвать с помощью меню Win dow 
⇒ Color (Окно ⇒ Цвет), рис. 1.3. Команды вызова всех палитр нахо-
дятся в меню Win dow (Окно). 
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Чтобы палитры не мешали рассматривать рисунок, можно убрать 
их все клави шей Shift+Tab. Эта же клавиша вернет их на место. Кла-
виша Tab убирает и по вторно вызывает на экран вообще все рабо-
чие области, кроме строки меню. Для переустановки расположения 
палитр (после беспорядка в результате перетаскивания) необходимо 
обновить рабочее пространство и выполнить команду Window ⇒ 
Work space ⇒ Reset Essential (Окно ⇒ Рабочая область ⇒ Сбросить 
Основная рабочая среда). 

В редакторе Adobe Photoshop CS6 существуют следующие палит ры:
 3D (3D) – для работы с трехмерной графикой;
 Action (Операции) – операции для автоматизации обработки;
 Adjustments (Коррекция) – цветовая коррекция изображений;
 Brush (Кисть) – выбор и настройка кисти;
 Brush Presets (Наборы кистей) – работа с выбранным набором 

кистей;
 Channels (Каналы) – использование цветовых и альфа-кана-

лов;
 Character (Символ) – назначение параметров для текстовых 

символов;
 Character Styles (Стили символов) – создание стиля тексто-

вых символов;

Рис. 1.3  Палитра Color (Цвет) и содержимое ее меню

Палитры
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 Color (Цвет) – создание цвета в конкретной цветовой модели; 
 Clone Source (Источник клонирования) – копирование фраг-

ментов из разных изображений;
 Histogram (Гистограмма) – вывод гистограммы текущего изо-

бражения;
 History (История) – сохранение состояний обрабатываемого 

изображения;
 Info (Инфо) – вывод информации о выделенной области, кур-

сора, цвета; 
 Layer Comps (Композиция слоев) – создание композиции из 

слоев для быстрого перехода; 
 Layers (Слои) – создание и редактирование слоев;
 Measurement Log (Журнал измерений) – сохраняет данные 

проведенных измерений;
 Navigator (Навигатор) – масштабирование и панорамирова-

ние просмотра;
 Notes (Комментарии) – работа с внесением заметок;
 Paragraph (Абзац) – установка параметров текстовых абзацев;
 Paragraph Styles (Стили абзацев) – создание и сохранение 

стиля абзацев;
 Paths (Контуры) – вывод и редактирование векторных кон-

туров;
 Properties (Свойства) – свойства корректирующих слоев и ма-

сок слоя;
 Styles (Стили) – использование различных стилей;
 Swatches (Каталог цветов) – наборы различных стандартных 

цветов;
 Timeline (Шкала времени) – работа по созданию анимации;
 Tool Preset (Настройки инструмента) – набор настроек ис-

пользованного инструмента. 

1.4. Панель управления
Инструменты можно настраивать с помощью панели управле ния, 
которая находится под строкой меню и имеет разный вид для раз-
ных инструментов. На рис. 1.1 вы видите панель управления для 
инструмента Move (Перемещение). Для того чтобы вывести панель 
управления на экран или спрятать ее, можно исполь зовать команду 
Window ⇒ Options (Окно ⇒ Параметры).
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1.5. Строка состояния
Строка состояния (рис. 1.1) расположена в нижней части рабочего 
окна документа. Здесь можно получить общую информацию о до-
кументе. В крайнем слева поле от ображается масштаб просмотра 
изображения. Содержимое второго слева поля зависит от того, что 
выбрано в меню строки состояния. По умолчанию здесь выводится 
информация о размерах документа.

Чтобы открыть меню строки состояния, щелкните на треугольнике 
справа от информационного поля, как на рис. 1.4. Вы можете вывести 
следующую информацию:

 Adobe Drive (Подключение к серверам Version Cue CS6); 
 Document Sizes (Размеры документа); слева от косой черты – 

приблизительный размер файла в формате Photoshop после слия-
ния его в один слой, справа – размер файла с учетом всех слоев; 

 Document Profile (Профиль документа) – цветовой профиль 
изображения;

 Document Dimension (Размер и разрешение документа) – ин-
формация о параметрах изображения;

 Measurement Scale (Шкала измерений) – масштаб проведения 
измерений;

 Scratch Sizes (Объем памяти); слева от косой черты – объем 
памяти, занятой всеми открытыми документами, справа – об-
щий объем оперативной памяти, который может использовать 
Photoshop;

 Efficiency (Эффективность); если это значение меньше 100%, 
значит, программе приходит ся обращаться к жесткому диску 

Рис. 1.4  Строка состояния и ее меню

Строка состояния
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из-за недостатка оперативной памяти и обработка изображе-
ния замедляется; 

 Timing (Хронометраж) – время, потраченное на последнюю 
операцию; 

 Current Tool (Текущий инструмент) – название активного 
инст румента;

 32-bit Exposure (Экспозиция 32-битных изображений);
 Save Progress (Сохранить ход выполнения) – показывает ход 

процесса сохранения изображения в процентах.
Щелкните на информационном поле. Пока кнопка мыши нажата, 

можно получить более подробную информацию об изображении, вы 
увидите табличку с размером, разрешением и цветовым профилем 
изображения.

После описания интерфейса графического редактора создадим 
свое рабочее пространство классического вида, существующее в ран-
них версиях и более привычное для опытных пользователей. 

С помощью команды Win dow (Окно) выберите следующие пали-
тры, которые мы будем в дальнейшем часто использовать: History 
(История); Layers (Слои) и Navigator (Навигатор). Командой Edit 
⇒ Preference ⇒ Interface (Правка ⇒ Настройки ⇒ Интерфейс) вы-
берите самый светлый из серых тонов раскраски рабочего простран-
ства. Также должны быть отображены панели инструментов и управ-
ления: команды Win dow ⇒ Tools (Окно ⇒ Инструменты); Window 
⇒ Options (Окно ⇒ Параметры).

Для сохранения созданного рабочего пространства выполните ко-
манду Window ⇒ Workspace ⇒ New Workspace (Окно ⇒ Рабочая 
область ⇒ Новая рабочая среда). В появившемся диалоговом окне 
задайте наименование рабочей среды Basic-1 (Базовая-1). После со-
хранения в списке рабочих пространств появится новое простран-
ство Basic-1 (Базовая-1), этот список также постоянно отображается 
в конце панели управления инструментом (рис. 1.5). 

Параметры рабочего пространства в дальнейшем вы можете ме-
нять по своему усмотрению (по привычкам, предпочтениям, в за-
висимости от поставленной задачи). Созданное нами новое рабочее 
пространство представлено на рис. 1.5. Восстановить параметры рабо-
чего пространства можно с помощью команды Window ⇒ Workspace 
⇒ Reset Basic-1 (Окно ⇒ Рабочая область ⇒ Сбросить Базовая-1). 
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Рис. 1.5  Новое рабочее пространство Basic-1 (Базовая-1)

Строка состояния



Глава 2
Растровая графика

Перед началом работы с Adobe Photoshop CS6 ознакомимся с осно-
вами растровой графики. Графический редактор Adobe Photoshop ра-
ботает в основном с растровой графикой, хотя умеет обращаться и с 
векторными контурами. Растровое изображение состоит из пикселей 
(от англ. pixels – элемент изображения) – разноцветных квадратиков 
одинакового размера [2, 4]. Компьютер запоминает цвета всех пик-
селей подряд в оп ределенном порядке. Поэтому растровые изобра-
жения требуют для хранения большого объема памяти. Их сложно 
масштабировать и еще сложнее редактировать. Чтобы увеличить 
изображение, приходится увеличивать размер квадратиков, и тогда 
рисунок получается ступенчатым. Для уменьшения изображения 
приходится несколько со седних точек преобразовывать в одну или 
выбрасывать лишние точки. В резуль тате изображение искажается, 
его мелкие детали становятся неразборчивыми.

2.1. Размеры и разрешение изображения
Размер растрового изображения обычно задается в пикселях шири-
ны на высоту ([width] × [height], размером прямоугольного массива). 
Геометрические размеры указываются в соответствующих единицах 
измерения длины, при этом следующим основным параметром стано-
вится разрешение растрового изображения. 

Разрешение – количество пикселей растрового изображения, при-
ходящихся на дюйм (или сантиметр). Физический размер пикселя 
отличается у разных дисплеев и принтеров, по этому, для того чтобы 
вычислить физические размеры изображения, необходимо знать раз-
решение устройства вывода изображения. 

Для лазерных принтеров характерно разрешение 1200 dpi и более 
точек на дюйм. Большинство мониторов может работать в разных 
режимах. Их стандартные размеры экрана в пикселях ppi: 1024×768, 
1280×1024, 1600×1200. Если размеры изображения в пикселях пре-
вышают размеры экрана, это не так страшно, так как все графические 
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редакторы умеют масштабировать их, заме няя несколько пикселей 
одним пикселем промежуточного цвета. 

Следующим основным фактором, влияющим на размер файла рас-
трового изображения, является цвет пикселя. Цвет пикселя задается 
битовой глубиной (количеством битов на отдельный пиксель). Све-
дения о размерах, разрешении и цветовом профиле изображения со-
храняются файле при записи в соответствующем формате.

2.2. Создание нового документа
Для создания нового документа необходимо выполнить команду File 
⇒ New (Файл ⇒ Новый). В диалоговом окне (рис. 2.1) можно за-
дать основные параметры растрового изображения. Имя файла вво-
дится в по ле Name (Имя). В поле Preset (Заготовки) можно выбрать 
изобра жение со стандартными параметрами. 

Рис. 2.1  Диалоговое окно 
создания нового документа New (Новый)

В поле Width (Ши рина) задается ширина изображения, а в поле 
Height (Высота) – его высота. В со седних с ними свитках можно 
выбрать единицы измерения: pixels (пиксели), inches (дюймы), cm 
(сантиметры), mm (миллиметры), points (пункты), picas (пики) или 
columns (колонки).

Разрешение задается обычно в pixels/inches (пикселях на дюйм), 
хотя можно выбрать и pixels/cm (пиксель на сантиметры). Далее вы-

Создание нового документа


